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Preface
INTRODUCTION
This chapter contains general information that will be useful to know before using the 
EVB-LAN8870-MC Evaluation Board User’s Guide. Items discussed in this chapter 
include:
• Document Layout
• Conventions Used in this Guide
• Warranty Registration
• The Microchip Web Site
• Development Systems Customer Change Notification Service
• Customer Support
• Document Revision History

DOCUMENT LAYOUT
This document describes the EVB-LAN8870-MC Evaluation Board as a development 
tool for the LAN8870, 1000BASE-T1 Ethernet Transceiver. The manual layout is as 
follows:
• Chapter 1. “Overview” – This chapter shows a brief description of the 

EVB-LAN8870-MC.
• Chapter 2. “Getting Started” – This chapter provides information about the 

setup and operation of the EVB-LAN8870-MC.
• Chapter 3. “Hardware Configuration” – This chapter includes information about 

the hardware configuration of the EVB-LAN8870-MC.
• Appendix A. “Schematics” – This appendix shows the EVB-LAN8870-MC sche-

matics.
• Appendix B. “Bill of Materials” – This appendix includes the EVB-LAN8870-MC 

Bill of Materials.
• Appendix C. “Silk Screens” – This appendix includes the EVB-LAN8870-MC 

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our web site 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 
document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics to open a list of available online help files.
 2024 Microchip Technology Inc. and its subsidiaries DS50003748A-page 5



EVB-LAN8870-MC Evaluation Board User’s Guide
silk screen.
• Appendix D. “PIC MCU Programming” – This appendix includes information on 

how to program the EVB-LAN8870-MC’s PIC18 MCU through MPLAB IDE.

CONVENTIONS USED IN THIS GUIDE
This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS
Description Represents Examples

Arial font:
Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...
Initial caps A window the Output window

A dialog the Settings dialog
A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK
A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>
Courier New font:
Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}

DS50003748A-page 6  2024 Microchip Technology Inc. and its subsidiaries
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WARRANTY REGISTRATION
Please complete the enclosed Warranty Registration Card and mail it promptly. 
Sending the Warranty Registration Card entitles users to receive new product updates. 
Interim software releases are available at the Microchip web site.

THE MICROCHIP WEB SITE
Microchip provides online support via our web site at www.microchip.com. This web 
site is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the web site contains the following 
information:
• Product Support – Data sheets and errata, application notes and sample 

programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE
Microchip’s customer notification service helps keep customers current on Microchip 
products. Subscribers will receive e-mail notification whenever there are changes, 
updates, revisions or errata related to a specified product family or development tool of
interest.
To register, access the Microchip web site at www.microchip.com, click on Customer 
Change Notification and follow the registration instructions.
The Development Systems product group categories are:
• Compilers – The latest information on Microchip C compilers, assemblers, linkers 

and other language tools. These include all MPLAB C compilers; all MPLAB 
assemblers (including MPASM assembler); all MPLAB linkers (including MPLINK 
object linker); and all MPLAB librarians (including MPLIB object librarian).

• Emulators – The latest information on Microchip in-circuit emulators.This 
includes the MPLAB REAL ICE and MPLAB ICE 2000 in-circuit emulators.

• In-Circuit Debuggers – The latest information on the Microchip in-circuit debug-
gers. This includes MPLAB ICD 3 in-circuit debuggers and PICkit 3 debug 
express.

• MPLAB IDE – The latest information on Microchip MPLAB IDE, the Windows Inte-
grated Development Environment for development systems tools. This list is 
focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and 
MPLAB SIM simulator, as well as general editing and debugging features.

• Programmers – The latest information on Microchip programmers. These include 
production programmers such as MPLAB REAL ICE in-circuit emulator, MPLAB 
ICD 3 in-circuit debugger and MPLAB PM3 device programmers. Also included 
are nonproduction development programmers such as PICSTART Plus and 
PIC-kit 2 and 3.
 2024 Microchip Technology Inc. and its subsidiaries DS50003748A-page 7
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CUSTOMER SUPPORT
Users of Microchip products can receive assistance through several channels:
• Distributor or Representative
• Local Sales Office
• Field Application Engineer (FAE)
• Technical Support
Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.
Technical support is available through the web site at: 
http://www.microchip.com/support

DOCUMENT REVISION HISTORY

Revisions Section/Figure/Entry Correction
DS50003748A 

(09-03-24)
Initial release
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Chapter 1. Overview
1.1 INTRODUCTION
The EVB-LAN8870-MC Evaluation Board is a 1000BASE-T1 (Single-Pair Ethernet) to 
1000BASE-T (Gigabit Ethernet) media converter used in evaluating the LAN8870 
1000BASE-T1 Ethernet transceiver.
The 1000BASE-T side of the EVB-LAN8870-MC uses a LAN8830 transceiver and a 
conventional RJ-45 jack with integrated magnetics. It features auto-negotiation and 
auto-crossover.
The 1000BASE-T1 side uses a LAN8870 transceiver with all necessary external filter-
ing and isolation components and an automotive single-pair Ethernet connector. The 
LAN8870 is configured in RGMII mode and connects to the RGMII interface of the 
LAN8830.
Software is provided to allow users to access the LAN8870 registers from a PC via the 
EVB-LAN8870-MC’s USB port and an on-board PIC microcontroller. The board can be 
powered from either the EVB-LAN8870-MC’s USB port or an external 5V supply.
This document describes the setup and use of the hardware and software. This docu-
ment also explains how to optionally reprogram the preprogrammed on-board micro-
controller. A simplified block diagram of the board is shown in Figure 1-1.

1.2 BLOCK DIAGRAM

FIGURE 1-1: BLOCK DIAGRAM
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1.3 REFERENCES
Concepts and materials available in the following documents may be helpful when 
reading this document. Visit www.microchip.com for the latest documentation.
• LAN8870 Data Sheet
• LAN8830 Data Sheet
• PIC18LF25K50 Data Sheet
• MCP1726 Data Sheet
• VMX7 Data Sheet
DS50003748A-page 10  2024 Microchip Technology Inc. and its subsidiaries

www.microchip.com
www.microchip.com


EVB-LAN8870-MC
EVALUATION BOARD
 USER’S GUIDE

Chapter 2. Getting Started
2.1 INTRODUCTION
This chapter outlines the steps for setting up and using the EVB-LAN8870-MC. It also 
provides guidelines on configuring the device with the EVB-LAN8870-MC Configura-
tion Tool Software.

2.2 PHYSICAL SETUP
The Microchip EVB-LAN8870-MC media converter is simple to set up, as shown in 
Figure 2-1. Perform the following procedure:
1. Verify that jumpers are installed on headers J5 and J16 (1-2).
2. To configure the 1000BASE-T1 port as slave, J5 must be open. Install a jumper 

on header J3. To configure it as master, do not install the J3 jumper.
3. The board is powered via a micro USB cable. Alternatively, 5V/500 mA can be 

applied at connector J1 or J13, with ground on J2 or J14.
4. A CAT5 Ethernet cable can be connected to the RJ-45 jack for 1000BASE-T.
5. For 1000BASE-T1, connect the single twisted pair cable to the automotive Ether-

net connector J9.

No further steps are needed for the board to pass full-duplex 1000 Mbps traffic between 
the two ports. Note that the CAT5 port must be linked at 1000 Mbps. 

Note: The EVB-LAN8870-MC is configured for auto-negotiation by default. 

FIGURE 2-1: EVALUATION BOARD CONNECTORS
 2024 Microchip Technology Inc. and its subsidiaries DS50003748A-page 11
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2.3 EVB-LAN8870-MC CONFIGURATION TOOL SOFTWARE
The optional EVB-LAN8870-MC Configuration Tool Software is available to monitor 
and configure the LAN8870 transceiver. Microsoft .Net 4.5 or newer must be installed 
on the PC. The software comes as an executable (.exe) file for Windows. No installa-
tion is required. To run it, double click on the file.
The PIC microcontroller on the board is running as a CDC device, so it sets up a serial 
communication port on the PC.
Once the software is started and the application window has opened, select the appro-
priate COM port for the evaluation board, and press the connect button as shown in 
Figure 2-2. 

FIGURE 2-2: COM PORT SELECTIONS
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Getting Started
The initial condition is a blank form with all values filled in with zero. Press the Read 
buttons to update the registers. With a successful connection to the board, you should 
be able to:
1. Read Clause 22 registers. (See Figure 2-3.)

2. Read Clause 45 registers. (See Figure 2-4.)

FIGURE 2-3: CLAUSE 22 REGISTER READ

FIGURE 2-4: CLAUSE 45 REGISTER READ
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3. Easily accomplish single READ and WRITE commands using the controls high-
lighted in Figure 2-5. For Clause 22 registers, the set is 00. For Clause 45 regis-
ters, the set is the Clause 45 Address Location of the Clause 45 register.

 

4. Load and execute configuration scripts. (See Figure 2-6.)

FIGURE 2-5: INDIVIDUAL READ AND WRITE COMMANDS
 

FIGURE 2-6: CONFIGURATION LOAD AND EXECUTE
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Getting Started
5. Gain access to TC10 commands for LAN8870 sleep setup, Sleep and Wake Up. 
(See Figure 2-7.) 

The PHY Address is copied from the general setup field (PHY Address [hex]).

The Load Script buttons allow users to load three different scripts to execute when the 
appropriate Execute button is clicked on. The execution of the script will be displayed 
inside the console window.
The following are commands supported inside the script:
• Blank Lines
• # Comment Lines
• sleep command
• r - Read command
• w45 - Write command
The script has to be in .txt format. All commands are lowercase letters. The sleep 
command is followed with a sleep time in [ms] as a decimal value.
The following is the format for a write, of 0xA08F to CL45 Address 0x01, CL45 Register 
0x808B:
w45 01 0x80 0x8B 0xA08F

The following is the format for a read of CL45 Address 0x1F, CL45 Register 0x0A02 for 
PHY with PHY Address of 0x15:
r 1F 0x0A 0x02 0x15

FIGURE 2-7: TC10 SLEEP AND WAKE COMMANDS
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Below is one example of the supported commands:
w45 07 0x02 0x00 0x0000

w45 01 0x80 0x93 0x8040

w45 01 0x80 0x8B 0x0084

w45 01 0x80 0xB0 0x001F

w45 01 0x80 0x94 0x0000

r 01 0x08 0x34 0x1F

r 01 0x0A 0x00 0x1F

2.4 QUICK START
Perform the following steps to quickly start using the board:
1. Connect a USB Micro-A cable to the EVB-LAN8870-MC USB port (J15).
2. Connect the 5V of an external supply to either J1 or J2. Connect the GND of the 

external power supply to either J13 or J14.
To implement any configuration changes, launch the MPLAB® X IDE software on your 
management PC and connect a PICKit™ 4 or a newer PICKit to J11 (aligning pin 1).
DS50003748A-page 16  2024 Microchip Technology Inc. and its subsidiaries
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Chapter 3. Hardware Configuration
3.1 INTRODUCTION
This chapter features the configuration options for the EVB-LAN8870-MC as well as 
detailed information on the jumpers, headers, status LEDs, and other essential parts of 
the board. 

3.2 HARDWARE CONFIGURATION OPTIONS
Figure 3-1 shows the top view of the EVB-LAN8870-MC.

3.2.1 Jumpers and Headers
The Section 2.4 “Quick Start”describes the basic setup of this media converter 
board. The one key configuration decision is whether the board is configured as a 
1000BASE-T1 master or slave. This is determined by jumper J3. The 1000BASE-T1 
links must always be statically configured with one end as a master and the other end 
as a slave. If both ends are the same type, the connection will not work.
The descriptions of the jumpers are given in Table 3-1, and the descriptions of the other 
headers are given in Table 3-2.

FIGURE 3-1: EVB-LAN8870-MC REV B (TOP VIEW)

TABLE 3-1: JUMPER DESCRIPTIONS
Jumpers Description

J3 Master-Slave mode/PHYAD2 Selection. 
If J5 is open: Open - Master. Closed - Slave
If J5 is closed: Open - PHYAD2 = 1. Closed - PHYAD2 = 0

J4 Speed/PHYAD4 Selection. 
If J5 is open: Open - 1000BASE-T1. Closed - 100BASE-T1
If J5 is closed: Open - PHYAD4 = 1. Closed - PHYAD4 = 0

J5 Managed Mode. Open - Autonomous mode 
 2024 Microchip Technology Inc. and its subsidiaries DS50003748A-page 17
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3.2.2 Status LEDs
Descriptions of the status LEDs are given in Table 3-3. 

3.2.3 1000BASE-T1 Connector
The board comes with an automotive Ethernet connector for the single twisted pair 
cable.

J6 Master-Slave mode/PHYAD3 Selection. 
If J5 is open: Open - Auto-Negotiation Enabled. Closed - 
Auto-Negotiation Disabled
If J5 is closed: Open - PHYAD3 = 1. Closed - PHYAD3 = 0

J16 Position 1-2: USB Powered.
Position 2-3: Ext 5V Power (Apply Positive 5V on either J1 or J13 
and GND on either J2 or J14)).

TABLE 3-2: HEADER DESCRIPTIONS 
Headers Description
J1 & J13 +5V power. This is an alternative to powering the board via USB.
J2 & J14 Ground

J4 These signals are controlled by the PIC microcontroller. They 
should not be controlled externally, but they may be monitored. 
Pin 1: MDC
Pin 2: MDIO
Pin 3: LAN8830 Reset
Pin 4: LAN8870 reset
Pin 5: Ground

J5 These signals are either controlled by the PIC microcontroller, or 
are outputs of the EVB-LAN8870-MC. Do not drive them exter-
nally.
Pin 1: WAKE_IN - Input to the EVB-LAN8870-MC
Pin 2: INH - Output from the EVB-LAN8870-MC

J11 5-pin PIC programming header
TP1 WAKE OUT test point
TP2 WAKE IN test point
TP3 INH test point
TP4 3.3V Power test point
TP5 GND test point

TABLE 3-3: LED DESCRIPTIONS
LEDs Description

D1 LAN8830 Reset indicator
D3 LAN8870 Link indicator
D4 LAN8870 Reset indicator
D6 3V3 indicator
D7 PIC Programming LED (On = PIC Initialization complete)
D8 Secondary LAN8870 Link indicator
D9 LAN8870 Master/Slave indicator
D10 5V indicator

TABLE 3-1: JUMPER DESCRIPTIONS (CONTINUED)
Jumpers Description
DS50003748A-page 18  2024 Microchip Technology Inc. and its subsidiaries



Hardware Configuration
3.2.4 Reset Push Button
The “SW1 Reset” push button resets the PIC microcontroller, which in turn resets both 
transceivers.
 2024 Microchip Technology Inc. and its subsidiaries DS50003748A-page 19
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Appendix A. Schematics

A.1 INTRODUCTION
This appendix shows the EVB-LAN8870-MC schematics.
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FIG

LAN8870 Media Converter
Designed with
URE A-2: LAN8870 SCHEMATIC 2
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Appendix B. Bill of Materials

B.1 INTRODUCTION
This appendix contains the EVB-LAN8870-MC Bill of Materials (BOM).
 2024 Microchip Technology Inc. and its subsidiaries DS50003748A-page 25
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facturer Manufacturer Part Number

0603YD105KAT2A

CGA2B3X7R1V104K050BB

GRM1555C1H180JA01D

C1005X7R1H104K050BB

 North America GRM188R61E106MA73D

 North America GRM155R6YA105KE11D

GRM155R60J475ME47D

nic Components ERJ-3GEY0R00V

C2012X7T2E104K125AA

C0805C472KARACAUTO

 North America GRM188R6YA475KE15D

LTST-C191KRKT

r MMBD914LT1G

LTST-C191KGKT

 North America BLM18EG221SN1D

MMZ1608B121CTAH0

 North America BLM18AG601SH1D

77311-118-02LF

L829-1J1T-43

9-2304372-9
TABLE B-1: EVB-LAN8870-MC BILL OF MATERIALS
Item Quantity Designator Description Populated Manu

1 2 C1, C33 CAP CER 1uF 16V 10% X5R SMD 0603 YES AVX

2 18 C2, C7, C14, C17, C19, 
C20, C26, C32, C43, C47, 
C49, C50, C53, C55, C57, 
C58, C59, C60

CAP CER 0.1uF 35V 10% X7R SMD 0402 YES TDK

3 4 C3, C4, C12, C13 CAP CER 18pF 50V 5% C0G SMD 0402 YES Murata 

4 20 C5, C9, C11, C16, C18, 
C22, C23, C25, C29, C30, 
C36, C37, C38, C41, C42, 
C51, C56, C61, C62, C68

CAP CER 0.1uF 50V 10% X7R SMD 0402 YES TDK

5 3 C6, C24, C35 CAP CER 10UF 25V 20% X5R SMD 0603 YES Murata Electronics

6 7 C8, C10, C28, C34, C39, 
C45, C54

CAP CER 1uF 35V 10% X5R SMD 0402 YES Murata Electronics

7 9 C15, C21, C27, C31, C44, 
C63, C64, C65, C66

CAP CER 4.7uF 6.3V 20% X5R SMD 0402 YES Murata

8 4 C40, C69, R60, R74 RES TKF 0R 1/10W SMD 0603 AEC-Q200 YES Panasonic Electro

9 2 C46, C52 CAP CER 0.1uF 250V 10% X7T SMD 0805 YES TDK

10 1 C48 CAP CER 4700pF 250V 10% X7R SMD 0805 YES KEMET

11 1 C67 CAP CER 4.7uF 35V 10% X5R SMD 0603 YES Murata Electronics

12 2 D1, D4 DIO RED 2V 20mA 54mcd CLEAR SMD 0603 YES Lite-On Inc

13 2 D2, D5 DIO RECT MMBD914LT1G 1V 10mA 100V SMD SOT-23-3 YES ON Semiconducto

14 6 D3, D6, D7, D8, D9, D10 DIO LED GREEN 2V 30mA 35mcd Clear SMD 0603 YES Lite-On Inc

15 4 FB1, FB2, FB3, FB10 FERRITE 220R@100MHZ 2A SMD 0603 YES Murata Electronics

16 2 FB4, FB8 FERRITE 600mA 120R SMD 0603 YES TDK

17 5 FB5, FB6, FB7, FB9, FB11 FERRITE 600R 500mA SMD 0603 YES Murata Electronics

18 4 J3, J4, J5, J6 CON HDR-2.54 Male 1x2 Gold 5.84MH TH VERT YES FCI

19 1 J7 CON MODULAR JACK RJ45 10/100/1000 MAGNETICS 2xLEDs 
SHIELD TH

YES Bel-Fuse

20 1 J8 CON HDR-1.8 MALE 1X2 TIN SHROUD 7MH TH R/A YES TE Connectivity
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68000-105HLF

ZX62-AB-5PA(31)

TSW-103-07-G-S

ACT1210G-800-2P-TL10

ERJ-3GEYJ102V

c RMCF0603FT100K

RC0402FR-074K7L

CRCW040210K0JNED

RC0402JR-070RL

CRCW040212K1FKEDC

RT0402BRD071KL

ERJ-2GEJ471X

 Product CRG0402F10K

RC0402FR-076K04L

RNCP1206FTD1K00

CRCW0603100KFKEAHP

ERJ-2RKF2000X

ERJ-2GE0R00X

ERJ-3EKF1001V

ERJ-2RKF2201X

c RMCF0603FT16K9

ERJ-2RKF1002X

ERJ-3EKF3300V

ERJ-3EKF2201V

 Product CPF0603F10KC1

PTS810 SJM 250 SMTR LFS

5117

5003

TA
er Manufacturer Part Number
21 1 J11 CON HDR-2.54 Male 1x5 Gold 5.84MH TH VERT YES FCI

22 1 J15 CON USB2.0 MICRO-AB FEMALE SMD R/A YES Hirose

23 1 J16 CON HDR-2.54 Male 1x3 AU 5.84MH TH VERT YES Samtec Inc

24 1 L1 CM CHOKE 2.4R@100kHZ 80uH SMD 3.2X2.5MM AEC-Q200 YES TDK

25 2 R1, R29 RES TKF 1k 5% 1/10W SMD 0603 YES Panasonic

26 2 R2, R30 RES TKF 100k 1% 1/10W SMD 0603 YES Stackpole Electronics In

27 5 R3, R7, R22, R26, R40 RES TKF 4.7k 1% 1/16W SMD 0402 YES Yageo

28 3 R4, R57, R63 RES TKF 10k 5% 1/16W SMD 0402 YES Vishay

29 16 R5, R9, R10, R11, R12, 
R13, R14, R15, R16, R17, 
R19, R20, R21, R28, R69, 
R70

RES TKF 0R 1/16W SMD 0402 YES Yageo

30 1 R18 RES TKF 12.1k 1% 1/16W SMD 0402 YES Vishay

31 13 R23, R27, R31, R36, R37, 
R38, R39, R45, R46, R47, 
R48, R49, R52

RES TF 1k 0.1% 1/16W SMD 0402 YES Yageo

32 2 R24, R25 RES TKF 470R 5% 1/16W SMD 0402 YES Panasonic

33 7 R32, R33, R34, R35, R43, 
R44, R50

RES TKF 10k 1% 1/16W SMD 0402 YES TE Connectivity Passive

34 1 R41 RES TKF 6.04k 1% 1/16W SMD 0402 YES Yageo

35 2 R42, R54 RES TF 1k 1% 1/2W SMD 1206 YES Stackpole Electronic Inc

36 1 R51 RES TKF 100k 1% 1/4W SMD 0603 YES Vishay

37 1 R53 RES TKF 200R 1% 1/10W SMD 0402 YES Panasonic

38 2 R55, R71 RES TKF 0R SMD 0402 AEC-Q200 YES Panasonic

39 3 R56, R65, R66 RES TKF 1k 1% 1/10W SMD 0603 YES Panasonic

40 2 R58, R59 RES TKF 2.2k 1% 1/10W SMD 0402 YES Panasonic

41 1 R61 RES TKF 16.9k 1% 1/10W SMD 0603 AEC-Q200 YES Stackpole Electronics In

42 2 R62, R72 RES TKF 10k 1% 1/10W SMD 0402 YES Panasonic

43 1 R64 RES TKF 330R 1% 1/10W SMD 0603 YES Panasonic

44 1 R67 RES TKF 2.2k 1% 1/10W SMD 0603 YES Panasonic

45 1 R73 RES TF 10k 1% 1/16W SMD 0603 YES TE Connectivity Passive

46 1 SW1 SWITCH TACT SPST 16V 50mA PTS810 SJM 250 SMTR LFS 
SMD

YES C&K Components

47 3 TP1, TP2, TP3 CON TP LOOP BLUE Ag TH YES Keystone Electronics

48 1 TP4 CON TP LOOP Orange TH YES Keystone Electronics

BLE B-1: EVB-LAN8870-MC BILL OF MATERIALS (CONTINUED)
Item Quantity Designator Description Populated Manufactur
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5001

ogy LAN8830/PSA

ogy LAN8870-V/PUAVAO

ogy PIC18LF25K50-I/ML

ogy MCP1726T-3302E/MF

ogy MCP1726T-ADJE/MF

ogy VXM7-9013-25M0000000

Solutions PPPC021LGBN-RC

68000-105HLF

0901210762

 Solutions 135-3701-211

assive Product CRG0402F10K

RC0402JR-070RL

facturer Manufacturer Part Number
49 1 TP5 MISC, TEST POINT MULTI PURPOSE MINI BLACK YES Keystone

50 1 U1 MCHP INTERFACE ETHERNET LAN8830 QFN-48 YES Microchip Technol

51 1 U2 MCHP INTERFACE LAN8870 1000BASE-T1 TRANSCEIVER YES Microchip Technol

52 1 U3 MCHP MCU 8-BIT 48MHz 32kB 2kB PIC18LF25K50-I/ML QFN-28 YES Microchip Technol

53 1 U4 MCHP ANALOG LDO 3.3V MCP1726T-3302E/MF DFN-8 YES Microchip Technol

55 1 U5 MCHP ANALOG LDO 0.8V-5V MCP1726T-ADJE/MF DFN-8 YES Microchip Technol

56 6 Y1, Y2 MCHP CRYSTAL 25Mhz 10pF SMD L3.2W2.5H0.8 YES Microchip Technol

57 2 J1, J2 CON HDR-2.54 Female 1x2 Gold TH R/A DNP Sullins Connector 

58 1 J10 CON HDR-2.54 Male 1x5 Gold 5.84MH TH VERT DNP FCI

59 2 J13, J14 CON HDR-2.54 Male 1x2 Gold 6.75MH TH R/A DNP Molex, LLC

60 1 J17 CON RF Coaxial MMCX Female 2P TH VERT DNP Cinch Connectivity

61 2 R6, R8 RES TKF 10k 1% 1/16W SMD 0402 DNP TE Connectivity P

62 1 R68 RES TKF 0R 1/16W SMD 0402 DNP Yageo

TABLE B-1: EVB-LAN8870-MC BILL OF MATERIALS (CONTINUED)
Item Quantity Designator Description Populated Manu
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Appendix C. Silk Screens
C.1 INTRODUCTION
This appendix shows the top and bottom silk screen images of the EVB-LAN8870-MC.
 2024 Microchip Technology Inc. and its subsidiaries DS50003748A-page 29



EVB-LAN8870-MC Evaluation Board User’s Guide
FIGURE C-1: EVB-LAN8870-MC TOP SILK SCREEN IMAGE
DS50003748A-page 30  2024 Microchip Technology Inc. and its subsidiaries



Silk Screens
FIGURE C-2: EVB-LAN8870-MC BOTTOM SILK SCREEN IMAGE 
 2024 Microchip Technology Inc. and its subsidiaries DS50003748A-page 31



EVB-LAN8870-MC Evaluation Board User’s Guide
NOTES:
DS50003748A-page 32  2024 Microchip Technology Inc. and its subsidiaries



EVB-LAN8870-MC
EVALUATION BOARD
 USER’S GUIDE

Appendix D. PIC MCU Programming

D.1 INTRODUCTION
The EVB-LAN8870-MC has a PIC18LF25K50 microcontroller that initializes the LAN8870 at power-on and 
provides users access to the registers via the USB interface. The PIC is already programmed, so users are 
not expected to reprogram it. However, the following instructions are provided for users who wish to 
reprogram it with modified initialization code.

D.2 SETTING UP MPLAB® X IDE AND MPLAB XC8 COMPILER
1. Download the latest MPLAB X IDE (6.xx) from the Microchip X IDE website.
2. Open the installer. (In Windows®, it will be in the Downloads directory.) Accept the license agreement 

and click on Next on every step to launch the installation.
3. After the installation is finished, the prompt will ask to launch additional items to install. For this, the 

XC8 Compiler is necessary but nothing else. See Figure D-1 for items to check and then click on Fin-
ish. This will open a webpage to the Microchip XC Compilers website.

FIGURE D-1: MPLAB X IDE SETUP WIZARD SCREEN
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4. On the Microchip XC Compilers website, download the MPLAB XC8 Compiler.
5. Open the XC8 Compiler installer (same directory as step 2 above). Accept the license agreement and 

click on Next on every step of the installation.
6. Once the installation is complete, click on Next (if activating a license, which is not necessary), acti-

vate your license, and then click on Next.

D.3 SETTING UP PROJECT IN MPLAB X IDE
7. Open MPLAB X IDE.
8. Go to File>Open Project.
9. Navigate to the folder where UNG8356_TX_T1_Version_1_USB.X folder is located. Highlight and 

click on Open Project. See Figure D-2.

FIGURE D-2: FOLDER NAVIGATION

10. This will open the project for the 1000BASET to 1000BASET1 PIC Program. (See Figure D-3.) 
Expand the project in the upper left corner. The PIC is programmed with the register reads and writes 
in the Initialize_LAN8870() function in the LAN8870.c file (double-click to open). The default pro-
gramming in this function is to set the EVB-LAN8870-MC to its best interoperability with other 
1000BASE-T1 link partners, but other reads and writes can be done after the default initialization.
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FIGURE D-3: PROJECT SCREEN

D.4 PROGRAMMING THE PIC
11. To program the PIC microcontroller, connect the programmer to J11 on the EVB-LAN8870-MC, with 

pin 1 of J11 lining up with pin 1 of the programmer. Note that the programmer may have additional 
lines which are not connected to the board’s J11 pins. This is acceptable.

12. Go to Production>Set Project Configuration> Customize. The window in Figure D-4 will appear. 
Choose the Hardware Tool (PICKit3, PICKit4, etc.) and XC8 compiler. Click on Apply and then click 
on OK.

FIGURE D-4: PROJECT CONFIGURATION SCREEN
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13. Now, the PIC can be programmed by clicking the green play button in the toolbar. Refer to Figure D-5.

FIGURE D-5: PROGRAMMING BUTTON IN TOOLBAR

14. This will program the PIC. The bottom right window in Figure D-6 will display the following when PIC 
programming is successful.

FIGURE D-6: PROGRAMMING CONFIRMATION

15. On the EVB-LAN8870-MC, press the Reset button. This will reset the PIC, which will initialize the 
EVB-LAN8870-MC registers.
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NOTES:
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